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Introducing CoreIDRAW® Technical Suite X6

CorelDRAWE® Technical Suite X6 is a complete and
cost-effective solution for both print and online visual
communications. It offers an array of applications
with new features and enhancements that streamline
the workflow of today’s technical communication
professionals and technical graphics users.

Access and repurpose technical design assets

With Corel DESIGNER® X6, you can confidently
work with data created by CAD engineers. You can
take advantage of XVL Studio 3D Corel Edition to
open, edit, modify, and import 3D models into your
technical illustrations. And with XVL Player, you can
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interactively insert 3D views and specify various
projections, angles, and basic cross-sections.

CorelDRAW Technical Suite X6 also provides industry-
leading file format compatibility, which ensures
smooth collaboration with colleagues and clients
alike. Whether it's AutoCAD® DWG and DXF Adobe®
llustrator® CS6, Adobe® Photoshop® CS6, Microsoft®
Publisher, or Adobe® Acrobat® X, you can access and
repurpose data from a wide range of formats. Plus,
Corel® CONNECT" X6 offers an easy and efficient way
to organize and find project assets.
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Create technical illustrations with precision

Corel DESIGNER X6 provides new and enhanced
specialized design tools for the specific tasks
required of technical illustrators. From dimension
lines, callouts, and annotations to threads and
wells, magnified views, projected measurements,
and precise alignment aids, Corel DESIGNER X6
offers everything you need to create clear and
accurate technical illustrations.

lllustrate with style and consistency

With Corel DESIGNER X6, you'll find many
convenient features that help you implement and
maintain a consistent style. A new styles engine
and Object Styles docker make it easy to ensure
consistency of all illustration elements, such as
lines, callouts, colors, dimensions, halos, and text.

A new Color Styles docker lets you use styles and
color harmonies to manage colors and quickly
implement project-wide color changes, which is
especially useful for producing iterative designs and
varying graphic outputs. In addition, new support
for advanced OpenType® and typesettings for Asian
and Middle Eastern languages help you output
multi-lingual publications with confidence.

CorelDRAW Technical Suite X6 also provides creative
design applications, such as CorelDRAW® X6 and
Corel® PHOTO-PAINT" X6, which are ideal for
producing downstream outputs from a technical
illustration, such as marketing collateral, graphics,
and presentation materials.
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Publish to technical communication standards

With it's industry-leading file format compatibility,
online and mobile 3D publishing options, support
for WebCGM and S1000D, CorelDRAW Technical
Suite X6 ensures that you can output for print
publication, the web, online Help systems, and
IETMs. You can also rely on compliance with various
standards-based systems, including Content
Management Systems (CMS), Product Data
Management (PDM), Product Lifecycle Management
(PLM), and Translation Memory Systems (TMS).

Increase performance, speed, and efficiency

The integrated, native 64-bit applications included
with CorelDRAW Technical Suite X6 are optimized
for multi-core processors, which is ideal for
working with large files and complex 3D data. The
new Property Manager docker presents only
selection-dependent options so you can apply
object formatting faster than ever before.

The suite also offers enhancements that help you
increase workflow efficiency, such as new support
for Symbol transparency, dynamic callout creation
based on object data, quicker and more agile
object selection, and the ability to interactively
place 3D-sourced illustrations as high-quality 2D
vector graphics.
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Customer profiles

Technical communication professionals

These users often have formal training in a
technical or graphics field, such as technical
illustration or technical writing. They work in
discrete manufacturing, automotive, aerospace,
telecommunications, architectural engineering and
construction (AEC), and apparel industries.

The graphics created by technical illustrators are
used in assembly instructions, user guides,
illustrated parts catalogs (IPCs), maintenance
manuals, schematics, or wiring diagrams. These
documents are output to various media, such as
print, the web, and interactive electronic technical
manuals (IETMs).

Technical communication professionals receive files
from colleagues and clients that were created with
various industry-standard applications. Within a
collaborative environment, the ability to repurpose
3D CAD and legacy files for multiple outputs is
critical to streamline processes.

In addition, many small to medium-sized
organizations rely on content authoring and
management systems, so they seek solutions that
can be easily integrated.

CoreDRAW
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Technical graphics users

These users are often self-taught in graphic design
and work in large enterprise environments, such as
manufacturing, automotive, telecommunication,

pharmaceuticals, chemicals, and energy industries.

Among their many tasks and responsibilities is the
need to create a variety of graphics, including
diagrams used in presentation materials, floor
plans, schematics, and marketing materials.

These users may create graphics from scratch or
base them on legacy files. They often work
collaboratively, and the graphics they create may
later be imported for reuse with office-productivity,
diagramming, and desktop-publishing software.

In a typical organization, there may be many
technical graphics users spread across several
departments. They are not generally required to use
the software daily, and as such, they do not often
get opportunities for extensive training.

They require cost-effective and easy-to-use
solutions that enable them to repurpose legacy files
and 2D CAD data, create basic technical diagrams,
and publish standardized outputs.
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What's included?

Applications

Corel DESIGNER® X6: This specialized
application streamlines the technical graphics
workflow by offering precision vector drawing,
page layout, and diagramming tools that meet
the demands of technical illustrators and
technical graphics users.

CorelDRAW® X6: This intuitive vector-illustration
and page-layout application is the perfect
partner for Corel DESIGNER. It offers technical
communication professionals additional creative
graphics and design tools that are ideal for more
artful endeavors, such as marketing collateral
outputs.

Corel® PHOTO-PAINT" X6: This professional
image-editing application lets you quickly and
easily retouch and enhance photos for both
technical communication and creative graphics
projects.

Corel® PowerTRACE® X6: This convenient
utility lets you quickly and accurately convert
bitmaps, such as scanned blueprints, into
editable vector graphics.

Corel CAPTURE" X6: This one-click utility lets
you capture images from your computer screen,
which is especially useful for creating illustrated
software documentation, such as user guides.

Corel® CONNECT" X6: This full-screen browser
connects you to the suite’s digital content library,
and lets you search your computer, local
network, and online sources to quickly find the
perfect complement for an illustration. Fully
integrated, it is also available as a docker in Corel
DESIGNER, CorelDRAW, and Corel PHOTO-PAINT.
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Corel® Website Creator™ X6: This application
offers a fast and easy way to design, build, and
manage websites.

XVL Studio 3D Corel Edition: This 3D
authoring application lets you create vector
illustrations and photo-realistic renderings from
3D views, including cross sections and 3D
element modifications.

XVL Player: This 3D viewer is integrated with
Corel DESIGNER X6 for the insertion of 3D data
assets in technical illustrations. It provides the
ability to modify 3D views and display modes.

Supporting applications

Microsoft® Visual Basic® for Applications 7.1:
This integrated development environment
includes 64-bit support and helps you streamline
your workflow by automating tasks.

Microsoft® Visual Studio® Tools for Applications 2.0:
This toolset includes the power of the .NET
framework, so you can create time-saving macros
to automate tasks and extend functionality.

Duplexing wizard: This wizard helps you
optimize your work for two-sided printing.

Barcode wizard: This wizard lets you generate
bar codes in a wide range of industry-standard
formats.

Bitstream® Font Navigator®: This award-
winning font manager for the Windows®
operating system helps you manage, find, install,
and preview fonts.
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Content

* More than 4,000 industry-standard
Architectural, Electrical, General, Mechanical,
and Tools symbols

* More than 350 templates, including more than
40 technical ANSI, DIN, and ISO standard
templates

* 10,000 high-quality clipart and images

* 1,000 all new professional, high-resolution
digital photos

* 1,000 OpenType® fonts, including premium
fonts, such as Helvetica®

* 800 frames and patterns

Documentation
* Online Help files
e User Guide (PDF)
* Macro Programming Guide (PDF)

* \/ideo tutorials
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Minimum system requirements

Microsoft® Windows® 8, Microsoft® Windows® 7
(32-bit or 64-bit editions), or Windows® XP (32-bit
edition), all with latest service packs installed

Intel® Pentium® 4, AMD Athlon” 64 or AMD"
Opteron

1 GB RAM

1.5 GB hard disk space (for typical installation
without content, additional disk space is
required during installation)

1024 x 768 or better monitor resolution
Mouse or tablet
DVD drive

Microsoft® Internet Explorer® 7 or higher

CoreDRAW

TECHNICAL
“Capesioner SUITE X0



Key features

CorelDRAW Technical Suite X6 is a complete and
cost-effective solution for both print and online
visual communications.

Access and repurpose technical design assets

Most technical illustrations, in 2D or 3D formats,
originate from data created by CAD engineers. A
technical illustrator will often use multiple
applications before finishing a design. The ability to
exchange this information between applications
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without losing data is critical to a technical
illustrator’s workflow.

New! XVL technology | Importing 3D models:
CorelDRAW Technical Suite X6 includes XVL Studio
3D Corel Edition, which lets you open, adjust, edit,
and modify 3D models for use in Corel DESIGNER
illustrations. When you send a 3D model from XVL
Studio 3D to Corel DESIGNER, it opens as a high-
quality vector illustration of the selected 3D view.

You can open and edit 3D models with XVL Studio 3D Corel Edition before sending a 3D view to Corel DESIGNER.

CoreDRAW
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XVL Studio 3D offers support for 3D file formats,
such as AutoCAD (DWG and DXF), 3D Studio Max
(3DS), Virtual Reality Modelling Language (VRML2),
and Universal 3D (U3D).

Give it a try

Importing a 3D model

1 In Corel DESIGNER X6, click File » 3D Import.
This will launch XVL Studio Corel Edition.

2 In XVL Studio Corel Edition, click File » Open,
navigate to the folder containing a supported
model that you want to use, and click Open.

3 On the View toolbar, click the ISO & ~ picker
and choose a preset ISO view.

4 |n the Structure panel, click the Add a
Snapshot @ button.

By creating a snapshot of the selected view, you can
return to that view for additional modifications.

5 Click Evaluation » Cross-section, click New
cross-section in the Cross-section List dialog
box, and then use the Cross-section cursor to
set the coordinates.

You can click each of the W, X, Y, and Z axes and
then drag to adjust the coordinates.

6 In the Edit Cross-section dialog box, click Add
and then Close.

7 In the Cross-section List dialog box, select
Profile-1, click Display cross-section, and
then click Close.

8 Click File » Save As to save your 3D work as an
XVL® file for future editing or for embedding as a
3D preview in Corel DESIGNER X6.

9 Click the Send to Corel DESIGNER i button,
specify any desired settings in the Send to Corel
DESIGNER dialog box, and then click Send.

10In the Import SVG File dialog box, specify any
desired settings, click OK, and then press Enter.
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New! XVL technology | 3D models in Corel
DESIGNER?® illustrations: \\ith the inclusion of
XVL Player, you can easily insert 3D models in Corel
DESIGNER illustrations. XVL Player lets you preview
3D models from different angles, specify parallel or
perspective projected views, and change the
orientation, position, and size of a 3D model. You
can also create a basic cross section, which is a
cutaway view so you can see inside the 3D object.

Give it a try

Inserting a 3D model

1 In Corel DESIGNER X6, click File » Insert 3D
Model, navigate to the folder containing a
supported 3D model, select it and click Open.

2 Drag on the drawing page to place a rectangular
container for the 3D model.

3 Hover the cursor over the container to access the

controls for the XVL Player, click the ISO & ~
picker and choose a preset I1SO view.

4 (Click the Switch Toolbar == ~ picker and
choose Cross-section Toolbar, and then click

the Create Cross-section ¢ button.

You can click each of the X, Y, and Z coordinates
on the Manipulater to adjust the cross-section.

5 Click the Edit Cross-section </ - picker, choose
Display Cross-section, and then click outside
the container to refresh the 3D model view.

To modify the 3D view again, double-click the
container.

CoreDRAW
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With the embedded interface of XVL Player, you can insert and modify 3D models in Corel DESIGNER illustrations.

Enhanced! Support for Adobe® CS6 and
Microsoft® Publisher: The enhanced import
support for Adobe® lllustrator® CS6, Adobe®
Photoshop® CS6, Microsoft® Publisher 2010, and
Adobe® Acrobat® X files, as well as enhanced
export support for Adobe® Illustrator® CS5 and
Microsoft® Publisher 2010 files, ensures that you
can easily exchange files with colleagues and
clients.

Enhanced! AutoCAD® 2013 support: Corel
DESIGNER X6 provides improved support for DWG
and DXF files from R2.5 to the most recent
AutoCAD 2013 file format, ensuring easy, error-free
data conversion when importing 3D CAD files. This
eliminates file format compatibility concerns when
working with customers or project partners.

New! Multiple trays in Corel® CONNECT": You
can now work with several trays concurrently,
which gives you increased flexibility for organizing
assets for multiple projects. In Corel CONNECT,
trays help you gather content from various folders

CoreDRAW
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or online sources, and are shared between Corel
DESIGNER, CorelDRAW, and Corel PHOTO-PAINT.

You can use separate trays for disparate types of
content; for example, you might have a project that
requires imagery and illustrations from multiple
components, such as machines. By keeping the
different articles separate, you can organize project
assets for more efficient discovery.

Give it a try

Working with multiple trays
1 In Corel CONNECT X6, click the Add new tray

[@] button, type web imagery to name the tray,
and then press Enter.

Repeat this step to create a tray named 3D files.

2 Type a web address in the Search and Address
box and press Enter.

For example, www.corel.com.

3 Click the web imagery tray tab and then drag
any images to the tray.

Reviewer’s Guide [ 9 ]



Give it a try

4 In the Folders pane, enable the Computer
check box, type a word or multiple words in the
Search and Address box, and then press Enter.
For example, to search for a specific 3D file, type
*.3ds (or any of the supported 3D file format
extensions).

5 Click the 3D files tab and then drag any file to
the tray.
You can now drag content from either tray and
drop it directly into a Corel DESIGNER project file.

New! Search capability in Corel® CONNECT":
A new search toolbar lets you instantly extract
images from a client’s website, making it quick and
easy to leverage content assets from online sources.
You simply type a web address in the Search box
and Corel CONNECT immediately gathers all images
defined with an HTML <img> tag from the web
site. You can also type search terms or a folder path
to have Corel CONNECT scour your computer,
network, or other online resources for content.

Corel® PowerTRACE® X6: Technical illustrators
and technical graphics users often base a new
illustration on an existing one. Legacy designs can
include scanned bitmaps of circuit design,
blueprints, schematics, hand-drawn sketches, as
well as drawings created with previous versions of
Corel DESIGNER.

With Corel PowerTRACE X6, you can quickly and
accurately convert bitmaps into editable and
scalable vector images. In addition, PowerTRACE
generates a color palette, which lets you instantly
edit, merge, or delete specific colors used in the
original bitmap.
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Create technical illustrations with precision

Technical illustrators require specialized tools
designed for very specific tasks. For instance, they
need the ability to work quickly and intuitively
when adding or fine-tuning dimension lines and
text, two-point lines, detailed annotations, callouts,
and measurements. The ability to call attention to
an element in an illustration by providing a
magnified view is also critical.

CorelDRAW Technical Suite X6 provides drawing
and diagramming tools that help users envision
with precision.

New! Measurements in projected space:
Technical illustrations are often used as build plans,
in which cases it is imperative to display precise
measurement values. Isometric projections are a
common visualization style for technical
illustrations, so the dimensioning must be readable
as well as clearly assigned to an object or portion of
a drawing. With Corel DESIGNER X6, you can use
Dimension tools to quickly and accurately measure
objects and distances in projected space.

With a planar measurement (left), the dimension line
does not follow the axes of the projected drawing
plane and the measurement does not recognize the
scale factor; with a projected measurement (right), the
dimension line follows the axes of the projected
drawing plane and the measurement is to scale.

Give it a try

Working with dimensions in projected space
1 In Corel DESIGNER X6, click the 2-point

Rectangle [ tool, and then choose Isometric
(30, 90, 30) from the Drawing profiles list box
on the property bar.

CoreDRAW
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Give it a try

2 On the property bar, click the Top [®/ button
(Ctrl+AIt+T), and then hold down Ctrl and
drag in the drawing window to create a square.

This square will be the top of a box.

3 On the property bar, click the Front [@] button
(Ctrl+AlIt+F), and then hold down Ctrl and
drag in the drawing window to create another
square.

This square will be the front of the box.

4 On the property bar, click the Right [#] button
(Ctrl+AIt+R), and then hold down Ctrl and
drag in the drawing window to create another
square.

This square will be the right side of the box.

5 Click the Center-Point Circle [/ tool
(Shift+C), hover over the front of the box until
the center snap point appears, and then drag
to create a hole in the box.

6 Click the Parallel Dimension [* tool, drag from
corner to corner of the top of the box, move the
pointer to position the dimension line, and then
click to place the dimension text.

from edge to edge in the circle, move the pointer
to position the dimension line, and then click to
place the dimension text.

Note that the dimension lines, extension lines,
and text measurements are projected to the
drawing plane.

Save the box drawing for use with the projected
Thread and Well tools.

New! Thread and well shapes in projected
space: Corel DESIGNER X6 provides new Projected
shape tools, which include Thread, Well, Cylinder,
and Prism tools. You can quickly and easily draw
thread and well shapes in projected space for the
creation of bolts, nuts, well nuts, and more. These
shapes are frequent requirements for detailed
technical illustrations, and are usually not included
in CAD and other 3D source files.

The ability to add this level of detail helps technical
illustrators ensure that their visualizations are clear,
with all required parameters specified onscreen.

CoreDRAW
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You can now quickly draw thread and
well shapes in projected space.

Give it a try

Working with threads and wells

1 In Corel DESIGNER X6, click the Thread [&]
tool.

2 Drag in the drawing window to set the radius of
the shape, then move the pointer to set the
length, and click.

3 On the property bar, specify the distance
between adjacent threads in the Pitch box.

4 In the Distance from start or end boxes,
specify values to set the distance from the first
thread to the start of the object and the distance
from the last thread to the end of the object.

You can also edit the thread's radius and length
by dragging either of the blue control handles.

5 Click the Well [&] tool, hover over the Right
projected side of the box until the center snap
point appears, drag to set the radius of the well
shape, then move the pointer to set the length,
and click.

6 On the property bar, specify the distance
between adjacent threads in the Pitch box.

7 In the Distance from start or end boxes,
specify values to set the distance from the first
thread to the start of the well and the distance
from the last thread to the end of the well.
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New! Identify and set the drawing scale:
When the Pick tool is active and no objects are
selected, Corel DESIGNER X6 displays the drawing
scale on the property bar. This prevents you from
having to dig through menus, making it easy to
instantly identify and adjust the drawing scale to
achieve properly proportionate distances.

With Corel DESIGNER X6, you can immediately identify
and change the drawing scale.

New! 3D-sourced illustrations at scale: \With
Corel DESIGNER X6, you can import 3D models as
2D vector graphics with a specified drawing scale.
This makes adding complementary 3D views to the
drawing easier, and ensures that 3D-sourced
illustrations display in a meaningful context.

Enhanced! Transformations docker: You can
now quickly apply even more precise transformations.
The enhanced Transformations docker makes it quick
and easy to apply pinpoint coordinates when moving,
rotating, resizing or scaling, mirroring, and projecting
graphical objects. The docker also includes a
convenient Copies option, which lets you apply
transformations to a specified number of copies while
leaving the original object unchanged.

New! Alignment guides: Corel DESIGNER X6
provides new, temporary Alignment Guides that
appear on the fly with suggested alignments to
existing objects on your page. This helps you
position objects more quickly and lay out a drawing
with precision.

The new Alignment and Dynamic Guides docker
makes it easy to customize the guides for specific
projects. In addition, the new Intelligent Spacing
and Intelligent Dimensioning options, help you to
precisely position, scale, and rotate an object in
relation to other onscreen objects.
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New! Create clip mask: Corel PHOTO-PAINT X6
offers technical illustrators and technical graphics
users a broad range of professional and advanced
photo-editing tools, which are ideal for producing
high-quality photo-based technical documentation.

With Corel PHOTO-PAINT X6, you can now adjust
the properties of a group of objects in a way that is
non-destructive to the individual objects within the
group. For example, you can adjust transparency
levels for the whole group without altering the
pixels of individual objects.

New! Smart Carver: Corel PHOTO-PAINT X6
includes the new Smart Carver, which makes it easy
to remove unwanted areas from a photo and
simultaneously adjust the photo's aspect ratio. For
example, you might need to define an area of a
photo that you would like to keep or remove, such
as an element that should not be included in the
documentation. The versatile Object Removal brush
lets you choose to paint either the area of the
photo that you want to preserve or the area that
you want to remove.

You can also use the Smart Carver to change a
photo’s aspect ratio without distorting anything in
the photo. For example, if you want to resize a
photo to fit into the dedicated page layout for your
documentation, you can paint the photo’s subjects
and then use the Smart Carving presets to contract
or expand the photo’s background vertically and
horizontally.
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lllustrate with style and consistency

The primary goal of a technical illustration is to be
clearly perceived. For a technical illustrator, working
on multiple illustrations for a complex project, the
ability to maintain consistency is imperative. And
this is especially so in a collaborative workflow, with
multiple colleagues contributing pieces to a project.

Whether it's consistent use of lines, callouts, colors,
dimensions, or text, adhering to corporate or

industry standards, or reusing proven visualization
practices, CorelDRAW Technical Suite X6 provides a
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plethora of applications and features that make it
easy to maintain a consistent style.

New! Styles engine and docker: The new
Object Styles docker makes it simple to create
outline, fill, halo, character, paragraph, frame,
callout, and dimension styles. You can also group
styles into style sets. You can edit a style or a style
set once and have the changes applied instantly
throughout a project. For example, you can define
style sets for callouts and dimension lines, and use
the style sets to consistently format all callouts and
dimension lines in a project.
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You can easily create and implement consistent styles and style sets by using the new Object Styles docker.

Give it a try

Working with styles and style sets

1 In Corel DESIGNER X6, click Window » Object
Styles.

2 In the Object Styles docker, click the New Style
button, and choose [2] Outline from the list.
An Outline 1 style appears in the Styles folder.

To rename the style, right-click it, click Rename,
type a new name, and press Enter.

CoreDRAW
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Give it a try

3 In the Outline area, specify any style attributes,
such as Width, Color, Line Style, and more.

4 Create an object on the drawing page, and then
click Apply to Selected in the Object Styles
docker. For example, a rectangle or an ellipse.

Repeat this step to create several different objects.

5 In the Object Styles docker, change some of the
outline style attributes.

All of the objects using that style are updated.
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Give it a try

6 In the Object Styles docker, click the new Style

Set [©] button, which is adjacent to the Style
Sets folder.

7 Click the Parallel Dimension tool, and drag
to add dimensions to each of the objects on the
drawing page.

8 Right-click Style Set 1, choose Add or Remove
Style, and then choose Dimension.

9 In the Dimension area of the Object Styles
docker, specify any dimension style attributes.

New! Color resources: The new Color Styles
docker lets you add the colors used in an illustration
document as resources, which makes it easier than
ever before to implement a project-wide color
change. To create a color style from an object, you
simply drag the object onto the Color Styles docker.
If you apply that color style to other objects, you can
quickly change the color and have it instantly applied
to all other objects linked to it.

In addition, you can break the link between an
object and its color style at any time, so that you
can then edit the object independently. Plus, you
can also convert color styles to different color
modes, or to spot colors to prepare an illustration
for production printing.

& .
7 Color Styles I [ESSEl™

The new Color Styles docker helps you create color
styles from the objects used in a drawing.
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New! Color harmonies: The new color harmony
functionality lets you group a document’s color
styles so that you can quickly and easily produce
iterative illustrations with varying color schemes. By
combining two or more color styles into a harmony,
you are linking the colors into a hue-based
relationship. This lets you modify them collectively,
altering the color composition of an illustration in
one step to quickly prepare a variety of alternate
color schemes. You can also edit the individual
color styles in a harmony.

You can use color harmonies to group an illustration’s
color styles, which makes it easier to create different
designs with varying color schemes.

New! Halo styles: You can now save any halo on
a curve as a style, which can quickly and easily be
applied to other curves in a project. Halos are used
to make flowcharts, and wiring and parts diagrams
easier to read where connector lines cross over one
another. Halos are also used to highlight the axes of
an exploded view in a technical illustration.

You simply right-click a curve with a halo, and then
click Object Styles » New Style From » Halo. The
Object Styles docker provides access to Halo
formatting options, which lets you adjust the color,
width, and opacity of the Halo style. To maintain
consistency throughout a project, you can instantly
apply that style to other curves.
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Give it a try

Working with Halo styles

1 In Corel DESIGNER X6, open or create a wiring
diagram containing several connector lines that
cross over each other.

2 Right-click a connector line, and then choose
Object Styles » New Style From » Halo.

3 In the New Style From dialog box, type a name
in the New Style Name area, and then click OK.

4 Apply the style to other connector lines in the
diagram by double-clicking the Halo style in the
Object Styles docker.

5 In the Object Styles docker, adjust any of the
following options:
* Width
* Color
* Opacity
All the connector lines with that halo style are
updated.

New! Advanced Opentype® support: \With
Corel DESIGNER X6, the reengineered text engine
lets you take greater advantage of advanced
OpenType® typography features, such as contextual
and stylistic alternates, fractions, ligatures, ordinals,
ornaments, small caps, swashes, and more.
OpenType fonts are based on Unicode, which
makes them ideal for cross-platform design work.
In addition, the extended character sets offer
outstanding language support.

Accessible from the Property manager docker, the
OpenType features let you choose alternative
appearances for individual characters, or glyphs, to
suit your stylistic preference provided that the font
supports advanced OpenType. For example, you
can apply a different number, fraction, or ligature
glyph to achieve a certain look for your text. In
addition, with the Interactive OpenType feature,
Corel DESIGNER X6 will suggest eligible OpenType
options that you can apply to your text.

New! Typesettings for Asian and Middle
Eastern languages: The new complex script
support built into the overhauled text engine
ensures proper typesetting for glyphs used by Asian
and Middle Eastern languages.
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New! Page numbering: \With Corel DESIGNER X6,
the new Insert page number command helps you
instantly add page numbers on all pages of a
document, starting on a specific page, or starting at
a particular number. This flexibility is ideal for
working with multiple Corel DESIGNER files that will
eventually become a single publication (for example,
a technical parts catalog).

You can choose from alphabetic and numeric
formats, including roman numerals, and you can
display page numbers in lower- or upper-case
lettering. In addition, page numbers are
automatically updated when you add or delete
pages in your document. You can also insert a page
number inside existing artistic or paragraph text.

You can now easily add page numbering that
updates automatically to multi-page documents,
such as user manuals.

New! PowerClip® and text frames: The new
empty PowerClip and text frame functionality in
Corel DESIGNER and CorelDRAW lets you populate
your designs with placeholder PowerClip and text
frames. This makes it easier to preview a layout
before finalizing its individual content components.

New! Placeholder text: \With Corel DESIGNER X6,
the new Insert Placeholder Text command lets
you right-click any text frame and immediately
populate it with placeholder text. This makes it easier
to assess the appearance of your documentation
prior to finalizing its content.
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For convenience and flexibility, you can also use
custom placeholder text in any language supported
by Corel DESIGNER X6. You simply create an RTF file
containing the text you want to use, save it to the
default placeholder text folder, and Corel DESIGNER
will use that text whenever you invoke the Insert
placeholder text command.

Publish to technical communication standards

The diagrams, graphics, and illustrations that are
created by technical graphics professionals are
viewed on a number of platforms — print, the
web, online Help systems, and IETMs. Therefore,
technical illustrators require output options that
ensure compliance with multiple standards-based
systems, including CMS, PDM, and PLM.

To that end, CorelDRAW Technical Suite X6
provides industry leading file format compatibility,
including WebCGM and S1000D, new and
enhanced features for outputting web graphics,
and much more.

New! XVL technology | 3D publishing for
online and mobile devices: You can use the
integrated XVL Studio 3D Corel Edition to save
supported 3D models to the XVL file format. The
free XVL Player is available for both desktop
browsers and mobile devices, which means that
you can share complex models with virtually
anyone.

Enhanced! CGM support: \When exporting CGM
files, you can preserve the level of detail and use full
bitmap compression. It is also easier to export to
interactive WebCGM 2 .x file format, which
preserves the attributes apside and apsname in the
XML Companion File (XCF). In addition, Corel
DESIGNER X6 supports the WebCGM 2-based
S1000D profile, which is an industry standard for
the specification of graphics for use in technical
publications in the highly regulated aerospace and
defense industries.
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Enhanced! Automated SVG export: You can
now automate the export of Scalable Vector
Graphics (SVG) while preserving all detail settings in
the exported files. SVG is used by the HTML5
standard to define vector graphics for the web, and
offers several advantages over bitmaps, such as the
ability for compression, indexing, high-quality
printing, scripting, searching, and zooming
without pixelation. In addition, as an XML graphics
file format, SVG is often used as source files for
Translation Memory Systems (TMS).

Corel DESIGNER X6 provides a powerful
automation interface, which lets you publish to
SVG as a background task. This also makes it easy
to integrate with advanced technical authoring
systems and any CMS.

Enhanced! Industry standard file format
support: \With support for more than 100 file
formats, including AutoCAD DWG and DXF,
Microsoft® Visio® (VSD), CGM, EPS, SVG, DOC,
DOCX, RTF, JPEG, PNG, TIFF, RIF, you can confidently
exchange files with customers and colleagues.
CorelDRAW Technical Suite X6 also supports the
PDF/A archiving format, so you can easily output
illustrations to the ISO-compliant format.
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Increase performance, speed, and efficiency

CorelDRAW Technical Suite X6 provides integrated,
native 64-bit applications that take full advantage
of multi-core processing power. This dramatically
minimizes wait times when working with large files
in Corel DESIGNER and CorelDRAW, and with
images in Corel PHOTO-PAINT. You'll also enjoy
increased efficiency when accessing data, exporting
files, and printing documents.

XVL Studio 3D Corel Edition is also available as a
native 64-bit application, offering significant
performance gains when working with 3D files. In
addition, the suite includes specialized tools, such
as the Object Data Manager for creating interactive
callouts, the Freehand Pick tool for better selection
control, and a 3D visualization component that lets
users interactively place and scale a 3D-sourced
illustration.

New! Streamlined callout creation: \\ith Corel
DESIGNER X6, you can now draw linked callouts by
snapping the callout arrowhead to a snap point in
an object. Linked, or ‘sticky’, callouts are attached
to the source object similarly to connector lines.
This means that when you move the source object,
the linked callout moves with it. You can also
specify how the callout behaves when the source
object is moved; for example, the entire callout
moves, or just the leader line moves while the
callout text maintains its position. In addition, you
can break the link at any time.

The Object Data Manager docker provides access to
the object properties of callout shapes, which
makes it easy to base callout text on object
properties. This means that callouts created with
object metadata are dynamic, and saves you time
from having to update callouts when you produce
iterative modifications of an illustration.
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You can create ‘sticky’ callouts, which are attached to
a source object (top);, when you move an object with
‘sticky’ callouts, you can specify the behavior of the
‘sticky” callout (middle),; you can also use data from an
object’s properties to display as dynamic callout text
(bottom).
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Give it a try

Working with callouts

1 In Corel DESIGNER X6, click the 2-point

Rectangle [ tool, and drag in the drawing
window to create a rectangle object.

2 Click the 1-Leg Callout [| tool (Shift+A), click
to place the arrowhead within the rectangle,
drag to complete the callout line outside the
rectangle, and then type some callout text.

The callout is now anchored to the rectangle.

then drag to move it.

Note how the callout leader line changes as you
move the rectangle.

4 Select the callout, and then on the property bar,
click the Link callout [ button, and choose
Move Linked Callout [+ from the list.

5 Move the rectangle again, and note how the
callout and leader line now move with the
anchor shape.

6 In the Object Manager docker, right-click the
rectangle, choose Rename, and then type a
custom name for the rectangle.

7 Click the 1-Leg Callout [] tool, click the Text
Source | . button, choose Object Property

from the list, and then draw a new callout from
within the rectangle.

8 In the Callout Data dialog box, disable the
Include Field Name option, and then click
Apply.

The new callout is automatically populated with
the rectangle’s custom name.

New! Interactive placement of imported 3D
views: \When you import 3D views in Corel
DESIGNER X6, you can place them and resize them
interactively similarly to other imported objects.

New! Freehand Pick tool: The new Freehand Pick
tool lets you marquee select objects by dragging
around areas of irregular shape. This save you time
by providing greater control over object selection
and transformation.
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New! Context-sensitive Property Manager
docker: In Corel DESIGNER X6, the redesigned
Property Manager docker now presents only
object-dependent formatting options and
properties. By grouping all object settings in one
location, this time-saving docker helps you fine-
tune your designs faster than ever before.

For example, if you create a rectangle, the Property
Manager docker automatically presents outline, fill,
and corner formatting options, as well as the
rectangle’s properties. If you create a text frame,
the docker instantly displays character, paragraph,
and frame formatting options, as well as the text
frame's properties.

The new Property Manager docker presents only
object-dependent formatting options, which makes it
faster and easier to modify objects.

New! Multi-core processor support: Corel
DESIGNER X6 has been optimized for the latest
multi-core processors. The increased support lets
you keep working while the suite performs
resource-intensive tasks in the background. The
result is fast and responsive performance, which
means less waiting when you export files, print
multiple documents, or copy and paste large
objects.

New! Native 64-bit support: \\ith support for
64-bit processors, CorelDRAW Technical Suite X6
applications enable you to work faster than ever
before with large, data-rich files.

New & Enhanced! Master layers: \\ith Corel
DESIGNER X6, the new and improved odd, even,
and all-pages Master Layers make it easier to create
page-specific designs for your multi-page
documents. If you are laying out multi-page
documents, such as parts catalogs and user
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manuals, it's now easy to incorporate page-specific
headers, footers, and page numbers. For example,
you might want a different header design to
appear on even pages than the one that appears
on odd pages.

New! Microsoft® Visual Basic® for
Applications 7.1: Microsoft® Visual Basic® for
Applications 7.1 provides 64-bit support for
developing high-performance custom solutions
and automations.
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Enhanced! Symbols: Corel DESIGNER X6 now
provides support for object transparency and styles
when working with symbols. Technical illustrators
often use symbols for standard drawing
components, which can appear multiple times in
an illustration. The ability to apply transparency to
symbols, and to create styles from symbols helps to
streamline your workflow. It also makes updating
and repurposing a technical illustration faster and
easier.
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You can now apply object transparency to symbols. In the lower gardening drawing, radial transparency has been
applied to four tree symbols so that instances of those symbols expose underlying shrubbery and floral elements.
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Optional Add-On: XVL Studio 3D CAD Corel® Edition

For organizations that require additional 3D editing
capabilities, CorelDRAW Technical Suite X6 offers
an upgrade to XVL Studio 3D CAD Corel Edition.
This upgrade provides native support for 3D CAD
systems used in discrete manufacturing, such as the
automotive, aerospace, and machinery industries.
XVL Studio 3D CAD Corel Edition lets users do more
with CAD files without the steep learning curve.

XVL Studio 3D CAD streamlines the workflow of
technical communication professionals by reducing
the need to consult design engineers when
preparing graphics content. It supports a broad
range of native 3D CAD file formats, such as CATIA,
SolidWorks, PTC Creo Parametric (formerly Pro/
ENGINEER), Autodesk Inventor, NX, and more. It
also supports 3D CAD exchange formats, such as JT,
IGES, STEP. and Parasolid.

Evaluation tools: Before 3D models and data can
be used in downstream applications, the integrity
of the 3D model requires validation. XVL Studio 3D
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CAD provides assembly evaluation tools for
geometry and measurements, interference check,
and collision detection so you can quickly verify the
integrity of a 3D assembly.

Additional 3D CAD tools: \With XVL Studio 3D
CAD, you can edit 3D models and combine 3D
models from different CAD sources. It provides a
rich 3D CAD toolset that lets you modify and
transform 3D parts, shapes, and assemblies.

Update / replace assembly functionality:
Once a design moves to the production phase,
construction changes are common. With XVL
Studio 3D CAD, you can update early designs at
any time due to changes determined by
construction. Disassembly views, animations, and
other 3D authoring functions are maintained, so
that you can efficiently update technical
illustrations with the most current revision of the
manufacturing design.

Wi o e B e e = —== = = | e’

The update or replace assembly functionality offered by XVL Studio 3D CAD Corel Edition helps you ensure that the
most current manufacturing revisions are reflected at any time in the visualization workflow.
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Animation tool set: XVL Studio 3D CAD provides
a full set of animation tools, including a dedicated
editing console as well as a method for automated
creation of disassembly animations. The
hierarchical structure of the Assembly Tree view
gives you full control over the creation of assembly,
sub-assembly, and part structures for use in
illustrated assembly and maintenence instructions.

Online and mobile outputs: XVL Studio 3D CAD
supports output of 3D models to HTML and for
mobile devices. By using the XVL file format, you
can share complex models with virtually anyone.

3D outputs: \With XVL Studio 3D CAD Corel Edition,
you can output to various 3D file formats, including
3DS, DXF, IGES, OBJ, STL, and VRML. You can also
publish to Universal 3D (U3D), which lets you insert
3D vizualization in PDFs.
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About Corel
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